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1. Important

This electronic user’s guide is intended for anyone
who uses the Philips monitor. Take time to read
this user manual before you use your monitor.

It contains important information and notes
regarding operating your monitor.

The Philips guarantee applies provided the
product is handled properly for its intended use,
in accordance with its operating instructions and
upon presentation of the original invoice or cash
receipt, indicating the date of purchase, dealer’s
name and model and production number of the
product.

1.1 Safety precautions and maintenance

) Warnings

Use of controls, adjustments or procedures other
than those specified in this documentation may
result in exposure to shock, electrical hazards
and/or mechanical hazards.

Read and follow these instructions when
connecting and using your computer monitor.

Operation

* Please keep the monitor out of direct sunlight,
very strong bright lights and away from
any other heat source. Lengthy exposure
to this type of environment may result in
discoloration and damage to the monitor.

* Remove any object that could fall into
ventilation holes or prevent proper cooling of
the monitor’s electronics.

* Do not block the ventilation holes on the
cabinet.

*  When positioning the monitor, make sure the
power plug and outlet are easily accessible.

* If turning off the monitor by detaching the
power cable or DC power cord, wait for 6
seconds before attaching the power cable or
DC power cord for normal operation.

*  Please use approved power cord provided
by Philips all the time. If your power cord is

missing, please contact with your local service
center. (Please refer to Customer Care
Consumer Information Center)

* Do not subject the monitor to severe
vibration or high impact conditions during
operation.

* Do not knock or drop the monitor during
operation or transportation.

Maintenance

» To protect your monitor from possible
damage, do not put excessive pressure on the
monitor panel. When moving your monitor,
grasp the frame to lift; do not lift the monitor
by placing your hand or fingers on the monitor
panel.

*  Unplug the monitor if you are not going to
use it for an extensive period of time.

*  Unplug the monitor if you need to clean it
with a slightly damp cloth. The screen may be
wiped with a dry cloth when the power is off.
However, never use organic solvent, such as,
alcohol, or ammonia-based liquids to clean
your monitor.

» To avoid the risk of shock or permanent
damage to the set, do not expose the monitor
to dust, rain, water; or excessive moisture
environment.

* If your monitor gets wet, wipe it with dry cloth
as soon as possible.

» If foreign substance or water gets in your
monitor; please turn the power off immediately
and disconnect the power cord.Then, remove
the foreign substance or water; and send it to
the maintenance center.

* Do not store or use the monitor in locations
exposed to heat, direct sunlight or extreme
cold.

* In order to maintain the best performance of
your monitor and use it for a longer lifetime,
please use the monitor in a location that falls
within the following temperature and humidity
ranges.

o Temperature: 0-40°C 32-95°F
o Humidity: 20-80% RH



Important information for Burn-in/Ghost image

* Always activate a moving screen saver
program when you leave your monitor
unattended. Always activate a periodic screen
refresh application if your monitor will display
unchanging static content. Uninterrupted
display of still or static images over an
extended period may cause “‘burn in”, also
known as “after-imaging” or “ghost imaging”,
on your screen.

*  "Burn-in", "after-imaging”, or "ghost imaging"
is a well-known phenomenon in monitor
panel technology. In most cases, the “burned
in” or “after-imaging” or "ghost imaging” will
disappear gradually over a period of time after
the power has been switched off.

D Warning

Failure to activate a screen saver, or a periodic
screen refresh application my result in severe
“burn-in" or “after-image” or "‘ghost image”
symptoms will not disappear and cannot be
repaired. The damage mentioned above is not
covered under your warranty.

Service

* The casing cover should be opened only by
qualified service personnel.

* Ifthere is any need for any document for
repair or integration, please contact with
your local service center. (please refer to the
chapter of "Consumer Information Center")

* For transportation information, please refer to
"Technical Specifications".

* Do not leave your monitor in a car/trunk
under direct sun light.

& Note

Consult a service technician if the monitor does
not operate normally, or you are not sure what
procedure to take when the operating instructions
given in this manual have been followed.

1.2 Notational Descriptions

The following subsections describe notational
conventions used in this document.

Notes, Cautions and Warnings

Throughout this guide, blocks of text may be
accompanied by an icon and printed in bold or
italic type. These blocks contain notes, cautions or
warnings. They are used as follows:

& Note

This icon indicates important information and tips
that help you make better use of your computer
system.

0 Caution
This icon indicates information that tells you how
to avoid either potential damage to hardware or
loss of data.

) Warning
This icon indicates the potential for bodily harm

and tells you how to avoid the problem.

Some warnings may appear in alternate formats
and may not be accompanied by an icon. In such
cases, the specific presentation of the warning is
mandated by the relevant regulatory authority.



1.3 Disposal of product and packing
material

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection.To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please

visit www.philips.com/about/sustainability/recycling.



2. Setting up the monitor

2.1 Installation

Bl Package contents

QSquart

PHILIPS

DVI (optional) VGA (optional)

Bl Install base stand

1. Place the monitor face down on soft and
smooth surface taking care to avoid scratching

or damaging the screen.

2. Snap in the base in the VESA mount area.

3. Hold the monitor base stand with both hands
and firmly insert the base stand into the base
column.

(1) Gently attach the base to the base column
until the latch locks the base.

(2) Use your fingers to tighten the screw
located at the bottom of the base, and
secure the base to the column tightly.




[l Connecting to your PC

PHILIPS

000000000

Kensington anti-theft lock
VGA input

DVI-D input

Display port (241B4LPY)
Audio input

AC power input

Zero power Switch

USB downstream

USB upstream

Connect to PC

-

Connect the power cord to the back of
the montior firmly.

Turn off your computer and unplug its
power cable.

Connect the monitor signal cable to the
video connector on the back of your
computer.

Connect the PC audio cable to the audio
connector on the back of your computer.
Plug the power cord of your computer
and your monitor into a nearby outlet.
Connect the USB upstream port on

the monitor and the USB port on your
computer with a USB cable. The USB
downstream port is now ready for any
USB device to plug in.

Turn on your computer and monitor.

If the monitor displays an image,
installation is complete.

2.2 Operating the monitor

ED/4

1 /¥ SENSOR /A /0K 0}

L
e 0 o o

El Front view product description

o o Switch monitor's power on and
off.

O =/0K |Access the OSD menu.

©® AV Adustthe OSD menu.

O | SENSOR |PowerSensor:

(5] 1 Adjust volume of the display

(6] <4 Return to previous OSD level.
Smartlmage. There are 6 modes

©@ @ [tobe selected: Office, Photo,
Movie, Game, Economy and Off.




E1 Description of the On Screen Display
What is On-Screen Display (OSD)?

On-Screen Display (OSD) is a feature in all Philips
monitors. It allows an end user to adjust screen
performance or select functions of the monitors
directly through an on-screen instruction window.
A user friendly on screen display interface is
shown as below:

On
PowerSensor -
off

Basic and simple instruction on the control keys

In the OSD shown above users can press v a
buttons at the front bezel of the monitor to move
the cursor, OK to confirm the choice or change.

The OSD Menu

Below is an overall view of the structure of the
On-Screen Display.You can use this as a reference
when you want to work your way around the
different adjustments later on.

Main menu Sub menu

— PowerSensor [ ©on
off

Input — VGA

— 0,1,2,3,4

DVI (available for selective models)

T

DisplayPort (available for selective models)

Picture Format — Wide screen, 4:3, 16:9, 1:1
[ Piceure Brightness ~ —— 0~100

Contrast — 0-100

SmartContrast — On, Off

Gamma — 1.8,2.0,22,24,26

Stand-Alone  — On, Off
L Audio

Mute —— On, Off

DP Audic  —— DP, Audio In (available for selective models)

Color Temp. —— S5000K, 6500K, 7500K, 8200K, 9300K, 11500K
— Color

sRGB

User Define Red: 0~100

E Green: 0~100
Blue: 0~100

— Language — English,Espafiol, Frangais, Deutsch, Italiano.

Portugués, Pycckuin, f#4

— Horizontal ~—— 0~100
— OSD Settings
— Vertical — 0~100
— Transparency —— Off.1,2,3,4
— OSD Time out — 5, 10, 20, 30, 60
— Auto
— Power LED — 01,234
— H. Position — 0~100
L Setup
— V. Position — 0~100
[— Phase — 0~100
— Clock — 0~100
— Resolution Notification —  On, Off
— Reset — Yes,No
L— Information




El Resolution notification Height adjustment

This monitor is designed for optimal performance
at its native resolution, 1920x%1080@60Hz.
When the monitor is powered on at a different
resolution, an alert is displayed on screen: Use
1920%x1080@60Hz for best results.

Display of the native resolution alert can be
switched off from Setup in the OSD (On Screen

Display) menu. /y/
+

= 100mm

B Physical Function
Tilt

Pivot

SWiVel % 900




2.3 Remove base stand and base El Remove the base

El Remove the base stand Condition:

Before you start disassembling the monitor base, ¢ ForVESA standard mounting applications

please follow the instructions below to avoid

damage or injury. 1. Extend the monitor base to its maximum
height.

1. Place the monitor face down on a smooth
surface, taking care to avoid scratching or
damaging the screen.

2. Place the monitor face down on a smooth
surface, taking care to avoid scratching or
damaging the screen.Then lift the monitor
stand.

2. Detach the base stand away from the base
column by:

(1) Use your fingers to loosen the screw
located at the bottom of the base.

(2) Gently move up-and-down to release the
latch that locks the base and pull the base
away from the base column.

3. While keeping the release button pressed, titt
the base and slide it out.




& Note

This monitor accepts a 100mm x 100mm
VESA-Compliant mounting interface.

PHILIPS

100mm

100mm




3. Image Optimization

3.1 Smartlmage
El Whatis it?

Smartlmage provides presets that optimize
display for different types of content, dynamically
adjusting brightness, contrast, color and sharpness
in real time. Whether you're working with text
applications, displaying images or watching a
video, Philips Smartimage delivers great optimized
monitor performance.

Ed Why do | need it?

You want a monitor that delivers optimized display
all your favorite types of content, Smartlmage
software dynamically adjust brightness, contrast,
color and sharpness in real time to enhance your
monitor viewing experience.

E How does it work?

Smartlmage is an exclusive, leading edge Philips
technology that analyzes the content displayed
on your screen. Based on a scenario you select,
Smartlmage dynamically enhances the contrast,
color saturation and sharpness of images to
enhance the contents being displayed - all in real
time with the press of a single button.

10

B How to enable Smartlmage?

Press @) to launch the Smartlmage on screen
display;

2. Keep pressing B to toggle between Office,
Photo, Movie, Game, Economy and Off;
3. The Smartimage on screen display will remain

on screen for 5 seconds or you can also
press”’OK” to make confirmation.

When Smartlmage is enabled, the SRGB
scheme is disabled automatically. To use sRGB
you need to disable Smartlmage with the B
button at the front bezel of your monitor.

Except using D key to scroll down, you can also
press w A buttons to choose and press "OK’ to
confirm selection and close the Smartimage OSD.



There are six modes to be selected: Office, Photo,
Movie, Game, Economy and Off.

@ Smartimage

Dffice

Photos

Movie

Game

Economy

Off

Office: Enhances text and dampens brightness
to increase readability and reduce eye strain.
This mode significantly enhances readability
and productivity when you're working with
spreadsheets, PDF files, scanned articles or
other general office applications.

Photo: This profile combines color saturation,
dynamic contrast and sharpness enhancement
to display photos and other images with
outstanding clarity in vibrant colors - all
without artifacts and faded colors.

Movie: Ramped up luminance, deepened
color saturation, dynamic contrast and razor
sharpness displays every details in darker
areas of your videos without color washout in
brighter areas maintaining a dynamic natural
values for the ultimate video display

Game: Turn on over drive circuit for best
response time, reduce jaggy edges for fast
moving objects on screen, enhance contrast
ratio for bright and dark scheme, this profile
delivers the best gaming experience for
gamers.

Economy: Under this profile, brightness,
contrast are adjusted and backlighting fine-
tuned for just right display of everyday office
applications and lower power consumption.
Off: No optimization by Smartimage.

11

3.2 SmartContrast
El What s it?

Unique technology that dynamically analyzes
displayed content and automatically optimizes a
monitor's contrast ratio for maximum visual clarity
and viewing enjoyment, stepping up backlighting
for clearer; crisper and brighter images or dimming
backlighting for clear display of images on dark
backgrounds.

E3 Why do | need it?

You want the very best visual clarity and viewing
comfort for every type of content. SmartContrast
dynamically controls contrast and adjusts
backlighting for clear; crisp, bright gaming and
video images or displays clear, readable text for
office work. By reducing your monitor's power
consumption, you save on energy costs and
extend the lifetime of your monitor:

E How does it work?

When you activate SmartContrast, it will analyse
the content you are displaying in real time to
adjust colors and control backlight intensity. This
function will dynamically enhance contrast for a
great entertainment experience when viewing
videos or playing games.



3.3 SmartSaturate
El Whatis it?

Smart technology that controls color saturation,
the degree to which one on screen color is
blended in neighboring colors, to deliver rich and
vibrant images for more entertainment fun when
you are viewing videos.

E3 Why do | need it?

You want rich, vibrant images for more
entertainment fun when viewing photos or
videos.

El How does it work?

SmartSaturate dynamically controls color
saturation, the degree to which on-screen color
is blended in neighboring colors, to deliver rich,
vibrant display for more entertainment fun when
you are viewing images or videos in your display's
Movie or Game mode. It is turned off for top
quality display of office application and in the
Economy mode to reduce power consumption.

12

3.4 SmartSharpness
El Whatis it?

Smart technology that enhances sharpness when
you need it for ultimate display performance and
more entertainment fun when you are viewing
videos or photos.

El Why do | need it?

You want the ultimate in sharpness for more
entertainment fun when viewing photos or videos.

E How does it work?

Smart technology enhances sharpness when you
need it for ultimate display performance and more
entertainment fun when you are viewing videos or
photos in the Movie or Game mode. It is turned
off for top quality display of office applications

and in the Economy mode to reduce power
consumptions.



3.5 Philips SmartControl Premium

The new SmartControl Premium software

by Phillips allows you to control your monitor

via an easy to use on-screen graphic interface.
Complicated adjustments are a thing of the past as
this user friendly software guides you through fine-
tuning resolution, Color calibration, Clock/Phase
adjustments, RGB White point adjustment, etc.

Equipped with latest technology in core algorithm
for fast processing and response, this Windows

'/ compliant eye catching animated Icon based
software is ready to enhance your experience
with Philips monitors!

El Installation

* Follow the instruction and complete the
installation.

* You can launch after installation is completed.

* If you want to launch later, you can either click
the shortcut on desktop or toolbar

PHILIPS

www philips.com/welcome

Monitor driver and software installation

piied Chinese

13

First launch -Wizard

* The first time after installation of SmartControl
Premium, it will automatically go to Wizard for
first time launch.

* The wizard will guide you through adjustment
your monitor performance step by step.

*  You can go to Plug-in menu to launch wizard
later on as well.

*  You can adjust more options without wizard
by Standard pane.

] smartControl Premium X

PHILIPS

SmartControl Premium

Preferences

Q

Audo

Adjust

Color Auto Prot

-

Waard

=
2
Presets

Options Theft Deterrence

L]

Help start Wiard



B3 Start with Standard pane:

Adjust menu:

* Adjust Menu allow you to adjust
Brightness, Contrast, Focus, Position and

Resolution.

¢ You can follow the instruction and do the

adjustment.

» Cancel prompts user if you want to cancel

installation.

e

SmartControl Premium

PHILIPS

Brightness
Improper adjusted Brightness i result n a fos of
detai in darker image areas. Adjust the Brightness for
the best possble picture qualty.

1. Lower the Brightness to the mnimum vl

2. Rase the Brightness to the desre feve,
3. Adust the Brightness as needed to achieve
an equal separaton of the strpes
Brghtness
Color
Contrast
an
B
= Brightess 100
Eco o oW
2 Positon
— 2203 Undo Reset
\Q Resolution —
Options
Help
[&] smartControl Premium e

SmartControl Premium

Brightness

§

Contrast

RS

Eco
. Postion
Y
\g Resolution
Options
Help

PHILIPS

Contrast

Adiust the Contrast (use the sider) to keep detals In
lighter image areas.

1. Raise the Contrast until the numbers 1 and 2
are no longer visole.

2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should reman barely visble.

Contrast

Gy

Undo Reset

@ srariContel Freriom

SmartControl Premium

]

Adjust
\% srghtness
Color
Contrast
\! roas
Eco
i postion
RN
\g Resoluton

Optons

&

e ——

SmartControl Premium

Contrast

Adjust
\g Brightness
Color

Resolution

QE e

SmartControl Premium

sightness
Color
contrast
A
Eco
poseon

AN
K;solumn

PHILIPS

Focus

Your display's tming needs to be synchronized with
the video signal
1. Choose Auto Setup.
f the vertical bands are stil visble, you'l need
0 adjust the Pitch.
Pitch: Try to make the vertical bands diapper.
Phase: Adjust to the brightest settng to minimze
movement on the screen.

Pich 50
= &
Phase %
= O—

Undo Auto Setup

2

PHILIPS

Position

Use the Position buttons to center the mage on
Your dply. Using this tool, you can postion the mage
up, down, left, or right.

Use the Up/Down buttons to center the image

vertaaly.
2. Use the Left/Right buttons to center the mage
horzontaly.

Undo Reset.

VI
PHILIPS

Resolution

You are currently 3t a Preferred resolution. For your
display to show crsp, clear text, colors, and mages,
Your dsplay should be set to s Preferred resolution
I your diplay s at 3 Non-Preferred resolution, cick
on the Preferred button to change your resolution to

™ Enable Resolution Notifier

Picture Format.
I 43 aspect ratio




Color menu:
Color Menu allow you to adjust RGB, Black
Level, White Point, Color Calibration, and
Smartimage (Please refer to Smartimage

section).

You can follow the instruction and do the

adjustment.

Refer to below table for sub-menu item base

on your input.

Example for Color Calibration

(€] soariont pomion

SmartControl Premium

Adijust
‘5 y
Color Black Level
\g whte Poe
Eco Display Gamma

¥ L

y Galbration
ap

Options Smartimage

€] SrariCoirot Fremiom

SmartControl Premium

Adiust
@ "
Color sadtove
\g whiront
Eco Display Gamma
5 J
cobratin
ap
Options Smartimege
Help

PHILIPS

RGB

Alldsplayed colors are produced by mixing Red, Bue,
and Green at different brightness levels. Choosing 2
neutral White Point wil give you optimal RGB. IF you
prefer to adjust the RGB now, folow these steps:

1. Adjust the itensty of the Red, Green, and

Bue using the sider bars.

NOTE: Changng the RGB values can adversely effect
the diplayed colors.

Red 100
o oW
Green 100
o oW
Blue 100
= oW

Undo Reset.

o
x

PHILIPS

White Point

‘White Point is the point at which equal combinations
of red, green, and blue ight at full ntensty create
white. This effects the overal color qualty. For the
most accurat colors clck the Reset button then
select the White Pont.
1. Please select the White Point value for the best
possble color qualty.

Whte Point 6500K

Undo Reset

[2] smartControl Premium

SmartControl Premium

Adjust
\5 =
Color sack Love
\g ines o
o Display Gamma
g LA
Gabraton
@ap
Options. Smartimage
Help

oS
PHILIPS

Display Gamma

Gamma is a companent of the pixel brightness n 3
display. A lower Gamma value produces brighter pixels
and a higher Gamma value produces darker pixels. The
default value for Gamma s 2.2.

To adjust Gamma, Smartimage must be set to OFf.
Clck the Smartimage OFf button before adjusting

1. Use the sider to select the desied Gamma,

Display Gamma

Smartimage Off

undo Reset.

e

SmartControl Premium

Adiust
\5 "
Color Black Level
\g whte pont
Eco Display Gamma
3 1
s g
CGalbration
ap
Options. Smartimege

i
PHILIPS

Calibration

Your dspiay needs to be propery calibrated n order
for & to produce the widest range of colors accuratey.
Calibration should always take piace 3s the kst tuning
step in the process. Remember to recaibrate any time
you make indidual adjustments to mage qualty or
whenever you move your display to 3 new location.

Make 3l other necessary adjustments to mage

qualty first.

Press Show Metoleam how to use the
calbrat

b, Dv!Ss Stat o beon the cabration

proce

F Enable color caibration

Color software designed in colaboration with Joseph

Holmes.

Protected by U.S. Patent No. 6,686,053

Show Me start

Quick View.

"Show Me" starts color calibration tutorial.
Start - starts the 6-step color calibration

sequence.

Quick View loads the before/after images.
To return to Color home pane, click the

Cancel button.

Enable color calibration - by default is on. If
unchecked, does not allow for color calibration
to happen, dimes out start and quick view

buttons.

Must have patent info in calibration screen.



First color Calibration Screen:

*  Previous button is disabled until the second
color screen.

* Next goes to the succeeding target (6-targets).

* Final next goes File>Presets pane.
»  Cancel closes the Ul and returns to the plug
in page.

Smartlmage
Allows user to change setting for better display
setting based on content.

When Entertainment is set, SmartContrast and
SmartResponse are enabled.

st 2%

SmartControl Premium PHILIPS

SmartImage

o ‘Smartimage provides dfferent brightness and
contrast levels to accomadate today's wide range of
computer applcations.

oy Choose the setting that s most comfortable or
e efficlent when viewing your applcation. Akematively,

3 I simply choose the one that best descrbes s type.
\' "
Bh!ﬂ.eve\

Color
xg White Point
e Display Gamma
gy~ LN o )
Galbration

ap

Options Smartimage = &

XQ * =

Help. Economy Game

ECO

[ r— @

SmartControl Premium PHILIPS

Schedule Power Savings

When powered on, the display & usng power, even f
the screen is biack. Adust the settngs on ths pane to
minimize the power usage during nactivey.

- Timers

Idle Timer - Use the Idle sider to set the standby
imode tmer. After the screen goes dark, any mouse
for keyboard activey restores the desktop.

IPower Off Timer - After the dplay enters standby.
imode, the Power OfF Tmer begins to count down.
lUse the Power Off sider to adjust the length of time
lbefore the display s automaticaly tumed off. Note
(Once the dispby off, the power button must be
|oressed to tum the dsplay back on.
[ schedue Daiy Power Off—————————
iselect the time and day for the display to Power OFF
automaticaly.
[17:00 ] T Monday I™ Tuesday I~ Wednesday
™ Thursday I~ Frday
I Saturday I Sunday

Power Savings

Schedule ?“owu savings

1de never
Options
S} &
Power Off 0 miute
(Sl &
Help standby Now Tum Power Off Now

Theft Deterrence Pane will only be active when
selecting Theft Deterrence Mode from the drop-
down Plug Ins menu.

e oy

SmartControl Premium PHILIPS

Theft Deterrence

‘Theft Deterrence protects your display against
unauthorized removal from your computer. To Enable
Theft Deterrence, cick on On. Frst-tme users wil
requre 3 Personal Identication Number (PIN). If the
dsplay s removed from this computer, ths PIN s
needed to authorge use on another Computer.

§

Adiust preferences
Audio

Auto Pvot

Presets
Theft: ‘!terrenu

SmartDesktop

Y EE!

‘Theft Deterrence OF



To enable Theft Deterrence, clicking Enable Theft
Deterrence Mode button brings up the following
screen:

*  User can enter PIN between 4 and 9 digits
numbers only.

* After entering PIN, Accept button takes user
to the pop-up dialog box on the following
page.

*  Minimum minutes set to 5. Slider set to 5 by
default.

*  Does not require the display be attached to
a different host to go into Theft Deterrence
mode.

] smartControl Premium 2%

SmartControl Premium PHILIPS

Theft Deterrence

Adjust vws‘?s‘wtf
Q
Audo
L]
Color e 9
~-
\g Iput
Eco v E'd
s a

After creating PIN, the Theft Deterrence pane will

indicate Theft Deterrence Enabled and provide

PIN Options button:

* Theft Deterrence Enabled is displayed.

* Disable Theft Deterrence Mode opens pane
screen on next page.

» PIN Options button only available after user
creates PIN, button opens secure PIN web
site.

Options>Preferences - Will only be active
when selecting Preferences from the drop-down
Options menu. On a non-supported display
capable of DDC/CI, only the Help and Options
tabs are available.

17

] sarGontot premiam 2%

SmartControl Premium PHILIPS

=

Adjust Preferences

=

Color

Preferences

N

o

Powersensor Setting
3 >

Power LED Button Brightness
- +

m
. 8

iw§

g2

&
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Help

Displays current preference settings.

A checked box enables the feature. The check
box is a toggle.

Enable Context Menu on desktop is checked
(On) by default. Enable Context menu
displays SmartControl Premium selections for
Select Preset and Tune Display in the desktop
right-click context menu. Disabled removes
SmartControl Premium from the right click
context menu.

Enable Task Tray icon is checked (On) by
default. Enable context menu shows the task
tray menu for SmartControl Premium. A right
click on the task tray icon displays the menu
options for Help, Technical Support. Check for
Upgrade, About, and Exit.When Enable task
tray menu is disabled, the task tray icon will
only display EXIT.

Run at Startup is checked (On) by default.
When disabled, SmartControl Premium will
not launch at start or be in the task tray. The
only way to launch SmartControl Premium is
either from the desktop short cut or from the
program file. Any preset set to run at startup
will not load when this box is unchecked
(Disabled).

Enable transparency mode (Windows 7,Vista,
XP). Default is 0% Opaque.



Options>Input - Will only be active when selecting

Input from the drop-down Options menu. On a
non-supported display capable of DDC/CI, only
the Help and Options tabs are available. All other
SmartControl Premium tabs are not available.

s

SmartControl Premium

=l

Adjust preferences
\g Audio
Color Auto Prot

Input.

Wizard

Eco
e 2
\!? presets
Options P

Theft Deterrence

Multi Monitors

DX

PHILIPS

Input

Your display has two inputs (connections on back of
this display) 50 you can hook up two dfferent sources
atthe sme e, U the. Analm] In and Digital In
buttons t u'd ke to view. You
S ety vl e aamiog I raoe.

IMPORTANT! If you switch inputs SmartControl may.
ol your monttor. In this case you
may have to use the Input Select button on the front
of your monitor to swich back to the original input.
before SmartControl functionalty can be restored.

Analog In Digical In

» Display the Source instruction pane and
current input source setting.
*  On single input displays, this pane will not be

visible.
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from the drop-down Options
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Help>User Manual - Will only be active when
selecting User Manual from the drop-down Help
menu. On a non-supported display capable of
DDC/CI, only the Help and Options tabs are
available.

S S P P

SmartControl Premium PHILIPS

User Manual
If you need help setting up or operating SmartControl,
n.

clck the Tech. Su You'l have the
option to fil ut a Form,

]

Adjust

User Manual

U

Color

p
®
Ubbte
|
Depiay
Eco
’ syam D
—
X8
Options
Help User Manual Tech. Support

Help>Version - Will only be active when selecting
Version from the drop- down Help menu. On a
non-supported display capable of DDC/CI, only
the Help and Options tabs are available.

[&] smartControl Premium X

SmartControl Premium PHILIPS

Version

artControl
jersion 0.00 EVALUATION dtune-pl-R2009-12-17-
04

i DDC/CI Communication: Yes - PDI APL

Copyright © 1993-2009 Portratt Dispays, Inc.

User Manul
Color

,
®
b
Eco
P
XX

Options

-/

Context Sensitive menu

The Context Sensitive menu is Enabled by default.
If Enable Context Menu has been checked in the
Options>Preferences pane, then the menu will be
visible.

g SmartControl
Select Preset 4
Tune Display

v Off
Office
Fhoto
Movie
Gatne
Economy

The Context Menu has four entries:

*  SmartControl Premium - When selected the
About Screen is displayed.

*  Select Preset - Provides a hierarchical menu
of saved presets for immediate use. A check
mark shows the currently selected preset.
Facoty Preset can also be called from the drop
down menu.

» Tune Display - Opens the SmartControl
Premium control panel.

*  Smartlmage - Check current settings, Office,
Photo, Movie, Game, Economy, Off.



Task Tray Menu Enabled

The task tray menu can be displayed by right-
clicking on the SmartControl Premium icon from
the task tray. Left Click will launch the application.

Help

Technical Support
Check for Update
About

Exik

The task tray has five entries:

*  Help - Access to User Manual file: Open User
Manual file using the default browser window.

* Technical Support - displays the tech support
page.

*  Check for Update - takes the user to PDI
Landing and checks the user's version against
the most current available.

* About - Displays detailed reference
information: product version, release
information, and product name.

*  Exit - Close SmartControl Premium
To run SmartControl Premium again either
select SmartControl Premium from Program
menu, double-click the desktop PC icon or
restart the system.

PHILIPS

SmartControl Premium

dtune-plp- 5-17-1143-21
Copyright © 1993-2010 Portrait Displays, Inc.
Patents Pending

Task Tray Menu Disabled

When the Task Tray is disabled in the preference
folder, only the EXIT selection is available. To
completely remove SmartControl Premium
from the task tray, disable Run at Startup in
Options>Preferences.
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3.6 SmartDesktop Guide
El SmartDesktop
SmartDesktop is in SmartControl Premium. Install

SmartControl Premium and select SmartDesktop
from Options.

] smartControl Premium 2

SmartControl Premium PHILIPS
SmartDesktop
\ Select desktop partiioning mode.
Adiust
s m

Vertical

Horizontal

ﬁ‘

Auto Pt
Color

Trple Vertical

Input

v =N
Eco
y Right Vertical Left Vertical
‘ 2 .
[
Theft Deterrence

Bottom Horzontal Top Horzontal

Options

off

&

Help Identfy

Align to partition check box will enable
automatic alignment for the window when
dragged into the defined partition.

Select the desired partition by clicking on the
icon. The partition will be applied to the
desktop and the icon will be highlighted.
|dentify provides a quick way to view the grid.

alfe ju i
sl e 1w
® lim fjn

L IRLUR . I
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E1 Drag and Drop Windows

Once the partitions are configured and Align to
partition is selected a window can be dragged
into the region and it will automatically align.
When the window and mouse cursor are within
the region, the region will become highlighted.

& Note

If the outline of the region is not visible when
dragging the window, “Show windows contents
while dragging” is disabled. To enable:

1. In Control Panel, click System.

2. Click Advanced system settings (ForVista &
Win7 OS, this is located on the left sidebar)

3. In Performance section, click Settings.

4. In the box, check Show window contents

while dragging, and click OK.

Other alternative path:

Vista

Control Panel > Personalization > Window
Color and Appearance > Click "Open Classic
appearance properties for more color options"
> Click "Effects" button > check Show window
contents while dragging

XP:
Display Properties>Appearance>Effects..> check
Show window contents while dragging

Win 7
No other alternative path available.



El Title Bar Options

Desktop partition can be accessed from the title
bar of the active window. This provides a quick
and easy way to manage the desktop as well as
sending any window to any partition without
having to drag and drop. Move the cursor into
the active window'’s title bar to access the drop
down menu.

B Right Click Menu

Right click on the Desktop Partition icon to view
the drop down menu.

e T —
Find Windows r l'_| lE| I£|
Desktop Partition  #

Identify Partition
prnforhelp = X

Align Off

Exit

1. Find Windows — In some cases, the user may
have sent multiple windows to the same
partition. Find Window will show all open
windows and move the selected window to
the forefront.

2. Desktop Partition — Desktop Partition shows
the current selected partition and allows the
user to quickly change to any of the partitions
shown in the drop down.

i oo 3 B
| Deckiop Pastson ] v
o
| Kot [}
nse g i o= tcaption | Heading1 || Bt =
22|V A- A [A]@] A a7 [ ]
cipbona 1 ont S oogeen - sopes
LT
SmartDesktop Guide ol
SmartDesktop - SmartDesktop is in SmartControl Premium. Install SmartControl Premium and select E
‘SmartDesktop from Options. ==
Jemcaasir 2x
Premium
SmartControl PHILIPS

& Note

If more than one display is attached, the user can
select the targeted display to change the partition.
The highlighted icon represents the current active
partition.

3. Identify Partition — Displays the outline grid
on the desktop for the current partition.

4. Align On/Align Off — Enables/disables the
drag and drop auto align feature.

5. Exit — Closes Desktop Partition and
Display Tune. To re-initialize, launch
Display Tune from the start menu or short cut
on the desktop.

22



H Left Click Menu A Task Tray Right Click

Left click on the Desktop Partition icon to quickly ~ The task tray also contains most of the features
send the active window to any partition without supported in the title bar (with the exception of
having to drag and drop. Releasing the mouse will  automatically sending a window to any partition).
send the window to the highlighted partition.

Bam ol e

Identify Partition
Align Off

Bright Light
Dim Light

Help

Technical Support
Check for Update
About

Exit

* Find Windows — In some cases, the user may
have sent multiple windows to the same
partition. Find Window will show all open
windows and move the selected window to
the forefront.

* Desktop Partition — Desktop Partition shows
the current selected partition and allows the
user to quickly change to any of the partitions
shown in the drop down.

* Identify Partition — Displays the outline grid
on the desktop for the current partition.

* Align On/Align Off — Enables/disables the
drag and drop auto align feature.
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SmartDesktop Partition Definitions

Name

two evenly sized horizontal regions.

For 90/270 maintain horizontal configuration.

Description Image
Full Desktop Applies all settings to the entire desktop.
Vertical Assesses the screen resolution and divides the display into

two evenly sized vertical regions.

For 90/270 maintain vertical configuration.
Horizontal Assesses the screen resolution and divides the display into

Vertical Triple

Assesses the screen resolution and divides the display into
three evenly sized vertical regions.

For 90 Partition 1 horizontal top Partition 2 horizontal
center Partition 3 horizontal bottom.

For 270 Partition 3 horizontal top Partition 2 horizontal
center Partition 1 horizontal bottom.

Vertical Split Left

Assesses the screen resolution and divides the display into
two vertical regions, the left hand side is a single region,
the right hand side is split into two evenly sized regions

For 90 Partition 1 on top Partition 2&3 on bottomFor
270 Partition 1 on bottom Partition 2&3 on top.

Vertical Split Right

Assesses the screen resolution and divides the display into
two vertical regions, the right hand side is a single region,
the left hand side is split into two evenly sized regions

For 90 Partition 1&2 on top Partition 3 on bottom.
For 270 Partition 3 on top Partition 1&2 on bottom.
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Name
Horizontal Split Top

Description

Assesses the screen resolution and divides the display into
two evenly sized horizontal regions, the top region is single,
the bottom region is spilt into two evenly sized regions

For 90 Partition 1 on right side Vertical Partition 2&3 on
left side Vertical.

For 270 Partition 1 on left side Vertical Partition 2&3 on
right side Vertical.

Image

Horizontal Split Bottom

Assesses the screen resolution and divides the display into
two evenly sized horizontal regions, the bottom region is
single, the top region is spilt into two evenly sized regions

For 90 Partition 1&2 on right side Vertical Partition 3 on
left side Vertical.

For 270 Partition 1&2 on left side Vertical Partition 3 on
right side Vertical.

Even Split

Assesses the screen resolution and divides the display into
four evenly sized regions.
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3.7 PowerSensor™

El How does it work?

» PowerSensor works on principle of
transmission and reception of harmless
“infrared” signals in order to detect user-
presence.

*  When the user is in front of the monitor
the monitor operates normally, at the
predetermined settings that the user has set-
i.e. Brightness, contrast, color, etc

*  Assuming that the monitor was set to 100%
of brightness for example, when the user
leaves his seat and is no longer in front of the
monitor, the monitor automatically reduces
the power consumption up to 80%.

User present in front User not present

((((( (599 ((((((’(((((((1((((‘

Power consumption as illustrated above is for reference purpose only

Bl Setting

Default settings

At its default setting, (Setting 3), PowerSensor
is designed to detect the presence of the user
located between 30 and 100 cm (12 and 40
inches) from the display and within five degrees
left or right of the monitor.

Custom settings

If you prefer to be in a position outside the

perimeters listed above, choose a higher strength

signal for optimal detection efficiency: The higher
the setting, the stronger the detection signal. For
maximum PowerSensor efficiency and proper
detection, please position yourself directly in front
of your monitor.

. If you choose to position yourself more than
100 cm or 40 inches from the monitor use
the maximum detection signal for distances
up to 120cm or 47 inches. (setting 4)

. Since some dark colored clothing tends to

absorb infrared signals even when the user
is within 100 cm or 40 inches of the display,
step up signal strength when wearing black
or other dark clothes.
. You can return to the default mode at any
time (setting 3)
Hot key

Sensor distance

Landscape/Portrait mode

Landscspe mode
((((((KIH)))

How to adjust settings

If PowerSensor is not operating correctly inside or

outside the default range, here's how to fine-tune

detection:

. Press the PowerSensor hot key

. You will find the default position 3’ on the
adjustment bar.

. Adjust the PowerSensor detection
adjustment to Setting 4 and press OK.

. Test the new setup to see if PowerSensor
properly detects you in your current
position.

. PowerSensor function is designed to work
in Landscape mode (horizontal position)
only. After PowerSensor turn on it, it will
automatically turn Off if the monitor is
used in Portrait mode (90 degree/vertical
position); it will automatically turn ON if
monitor is returned to its default Landscape
position.

& Note

A manually selected PowerSensor mode will

remain operational unless and until it is readjusted

or the default mode is recalled. If you find that
the PowerSensor is excessively sensitive to nearby
motion for some reason, please adjust to a lower
signal strength.



4 Technical Specifications

Monitor panel type TFT-LCD

Backlight LED

Panel size 24" W (61.0 cm)
Aspect ratio 16:9

Pixel Pitch 0.277 x 0.277 mm
Brightness 250 cd/m?
SmartContrast 20,000,000:1
Contrast ratio (typical) 1000:1

Response time (typical) 5ms

Optimum Resolution 1920 x 1080 @ 60Hz
Viewing angle 170° (H) / 160° (V) @ C/R > 10
Picture Enhancement Smartlmage

Display colors 167 M

Vertical refresh rate 56Hz -76Hz
Horizontal Frequency 30kHz - 83kHz

sRGB YES

Signal input (241B4LP)

DVI-D (Digital),VGA (Analog)

Signal input (241B4LPY)

DVI-D (Digital), VGA (Analog), Display port

USB

USB20x2

Input Signal Separate Sync, Sync on Green

Audio In/Out PC audio-in, headphone out

Built-in speakers 1.5W x 2

User Convenience /< (A 4 SENSOR /A /0K 0)

OSD Languages

English, French, German, Italian, Russian, Spanish,
Simplified Chinese, Portuguese

Other convenience

VESA mount ( 100 x 100mm), Kensington lock

Plug & Play Compatibility

DDC/CI, sRGB, Windows 7/Vista/XP Mac OSX, Linux

Tilt -5/+20
Swivel -65/+65
Height adjustment 100mm




On mode

21.5W (typ.), 38W (max.) (with audio and USB x 2)

On mode (ECO mode) (typical)| 12W

Energy Consumption AC Input Voltage at | AC InputVoltage at [ AC Input Voltage at

(EnergyStar 5.0 test method) T00VAC +/-5VAC, [ 115VAC +/-5VAC, | 230VAC +/-5VAC,
50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/ -3Hz

Normal Operation (typical) 20.81W 20.75W 20.82W

Sleep (typical) 01W 01W 01W

Off ow oW ow

Heat Dissipation®

AC Input Voltage at
100VAC +/-5VAC,

AC Input Voltage at
115VAC +/-5VAC,

AC Input Voltage at
230VAC +/-5VAC,

50Hz +/ -3Hz 60Hz +/ -3Hz 50Hz +/ -3Hz
Normal Operation 71.02BTU 70.82BTU 71.06BTU
Sleep (typical) 0.34BTU 0.34BTU 0.34BTU
Off O0BTU OBTU O0BTU
On mode 26W (typ.), 39W (max.) (with audio and USB x 2)

On mode (ECO mode) (typical)

12W

Energy Consumption
(EnergyStar 5.0 test method)

AC Input Voltage at
100VAC +/-5VAC,

AC Input Voltage at
115VAC +/-5VAC,

AC Input Voltage at
230VAC +/-5VAC,

50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/ -3Hz

Normal Operation (typical) 21.57W 21.44W 21.42W

Sleep (typical) 01W 01W 01W

Off ow ow ow

Heat Dissipation® AC Input Voltage at | AC InputVoltage at | AC InputVoltage at
100VAC +/-5VAC, | 115VAC +/-5VAC, | 230VAC +/-5VAC,
50Hz +/ -3Hz 60Hz +/ -3Hz 50Hz +/ -3Hz

Normal Operation 73.62BTU 73.17BTU 7311BTU

Sleep (typical) 0.34BTU 0.34BTU 0.34BTU

Off 0BTU OBTU 0BTU




Power LED indicator

On mode: White, Standby/Sleep mode: White (blinking)

Power Supply

Product with stand (WxHxD)

Built-in, 100-240VAC, 50/60Hz

565 x 403 x 227mm

Product without stand
(WxHxD)

565 x 352 x 55mm

Box dimension (WxHxD)

624 x 405 x 172mm

Temperature range

Product with stand 6.3kg
Product without stand 4.3kg
Product with packaging 8.3kg

Storage: -20°C to 60°C

operation: 0°C to 40 °C

Relative humidity

20% to 80%

Altitude Non-operation: + 40,000 ft ( 12,192 m)
operation: + 12,000 ft ( 3,658 m)
MTBF 30,000 hrs
| Ewionmenw ]
ROHS YES
EPEAT Gold. (www.epeat.net)
EnergyStar 5.0
Packaging 100% recyclable

Specific Substances

Regulatory Approvals

PVC BFR free housing

BSMI, CE Mark, FCC Class B, GOST, SEMKO, TCO Certified, UL/
cUL, 1SO9241-307, TUV-GS, TUV-Ergo

Color Black/Silver
Finish Texture
& Note

1. EPEAT Gold or Silver is valid only where Philips registers the product. Please visit www.epeat.net for

registration status in your country.

2. This data is subject to change without notice. Go to www.philips.com/support to download the latest

version of leaflet.
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4.1 Resolution & Preset Modes

El Maximum Resolution

For 241B4LP/241B4LPY
1920 x 1080 at 60 Hz (analog input)
1920 x 1080 at 60 Hz (digital input)

Bl Recommended Resolution

For 241B4LP/241B4LPY
1920 x 1080 at 60 Hz (digital input)

[H.freq (<Hz) | Resolution [ V.freq (Hz) |
31.47 640x480 59.94
37.88 800x600 60.32
48.36 1024x768 60.00
54.00 1152x864 60.00
44.77 1280x720 59.86
47.78 1280x768 59.87
49.70 1280x800 59.81
60.00 1280x960 60.00
63.89 1280x1024 60.02
47.71 1360768 60.02
5547 1440x900 59.90
55.94 1440x900 59.89
75.00 1600x1200 60.00
64.67 1680x1050 59.88
65.29 1680x1050 59.95
66.59 1920x1080 59.93
74.04 1920x1200 59.95
67.50 1920x1080 60.00

& Note

Please notice that your display works best at
native resolution of 1920 X 1080@60Hz. For
best display quality, please follow this resolution
recommendation.
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5. Power Management

5.1 Automatic PowerSaving

If you have VESA DPM compliance display card

or software installed in your PC, the monitor can
automatically reduce its power consumption when
not in use. If an input from a keyboard, mouse or
other input device is detected, the monitor will
‘wake up' automatically. The following table shows
the power consumption and signaling of this

automatic power saving feature:

VESA Video | H-sync | V-sync Power Used | LED color
Mode
Active ON Yes Yes 21.5W (typ.), White
38W (max.)
(with audio and
USB x 2)
Sleep (typ.)| OFF No No 01W White
(Blinking)
Switch Off| OFF - - ow OFF

VESA Video | H-sync | V-sync Power Used | LED color
Mode
Active ON Yes Yes 26W (typ.), White
39W (max.)
(with audio and
USB x 2)
Sleep (typ.)| OFF No No 0.1W White
(Blinking)
Switch Off | OFF - - oW OFF

The following setup is used to measure power
consumption on this monitor.

Native resolution: 1920x1080.

Contrast: 50%

Brightness: 250 nits

Color temperature: 6500k with full white pattern
Audio and USB Inactive (Off)

e Note

This data is subject to change without notice.
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6 Regulatory Information

Lead-free Product
Lead free display promotes
@ environmentally sound recovery and
Bl disposal of waste from electrical and

electronic equipment. Toxic substances
like Lead has been eliminated and compliance
with European community’s stringent RoHs
directive mandating restrictions on hazardous
substances in electrical and electronic equipment
have been adhered to in order to make Philips
monitors safe to use throughout its life cycle.

Congratulations,
Your display is designed for both you and the

planet!

is designed, manufactured and

tested according to some of the
strictest quality and environmental requirements
in the world. This makes for a high performance
product, designed with the user in focus that also
minimizes the impact on the climate and our
natural environment.

The display you have just purchased
carries the TCO Certified label.
This ensures that your display

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast, resolution,
black level, gamma curve, colour and luminance
uniformity and colour rendering

* Products are tested according to rigorous safety
standards at impartial laboratories

* Electric and magnetic fields emissions as low as
normal household background levels

* Low acoustic noise emissions (when applicable)

Some of the Environmental features of the TCO
Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

* Very low energy consumption both in on- and

standby mode minimize climate impact

Restrictions on chlorinated and brominated

flame retardants, plasticizers, plastics and heavy

metals such as cadmium, mercury and lead

(RoHS compliance)

* Both product and product packaging is prepared
for recycling

* The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [Tmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

For displays with glossy bezels the user should
consider the placement of the display as the bezel
may cause disturbing reflections from surrounding
light and bright surfaces.
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EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
Environmental Assessment Tool)
program evaluates computer
desktops, laptops, and monitors
based on 571 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

X
Q:b
)

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)
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2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on ISO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields for Visual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO certified (Requirement for Environment
Labeling of Ergonomics, Energy, Ecology and
Emission, TCO: Swedish Confederation of
Professional Employees) for TCO versions

Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner,

m we have determined that this
product meets the ENERGY STAR®

guidelines for energy efficiency.

2

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

© This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.
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Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques

de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont congues

de fagon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
signaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, I'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre I'équipement et
le récepteur.

*  Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
* Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it is & Class A devics on the epscification label. The following appliss to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The ussr of the
davics is obliged to take all steps necessary to remove sources of intarference 1o tela-
communication or other devicas.

Pokud neni na typovém Stfthu poditade uvedeno, 2o spadé do do tfidy A podie EN 55022,

do ffidy B podie EN 55022, Pro zafizen! zafazend do tidy A (chranné
pésma 30m) podie EN 55022 platl nésledujici. Dojde-li k rudien! telekomunikatnich nebo
Fnjich zafizeni je u3ivatal povinnen provést takove opatignl, aby neni odstranil,




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor; printer; and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji
Urzadrernie powinng by zasilane z priazds 2 preybaceonym obwodemn ocheonmym (gniasdo 2
kalkiensh. Wphlpracugaee o soby urzsdeonia (komputer, monstor, drukarka) powinisy byé zasilase
& bepo samego Al
Instalacja elekts
preed ewarciami, w pmuc. bezpreceniki o
Woeelu catkowitego wylgesmia ursqdees
easilajacega 2 griazdla, kidre powinng

Znak beeplecrefsiwa "B potwiendeas —’p\dllmi‘ uregdzenia @ wymaganiami berpieceenatwa
whytkowaria sawartym w PNALTA2107  PR-BOE6251

Eazonym 1
i rmamianave] e wigkszej niz 164 (amperie ).
ci zasilania, nalezy wyjaé wiyeeky kabla

ad 53¢ W pobliz urzs u.ma 1 bt Bt dosleprne.

Pozostale instrukcje bezpieczensiwa

* N maledy whywad wiyesek sdapteeowyeh lib isiwad kolk obwodu ochronnega 2 wiyezki
Jezel hemaecane jesttyeis previlhizacea 1 aalszy vyt preediusaces S-iylowegs <

System k P ——— ¢ proed magiymi, i warostami lub spad-
ki mapigein, uiywias eliminators preepiet, urzdrenia depasvwsjaoege lub
s zasilaia

ic lezalo i ksblsch systeeny komputzeowego, araz aby kable e
dese mindna bybaby na i nadeptywad lub potykad s o i,

ani iy b 1 st knmpuh Ty

ydem, puprzes svwarci
putzeowy powiisien zngjdowal sie 2 dala od gra

ey blokawad alworiw wentylacyinych. Nabeiy anzka
kampuler o amieszezania kamputer vw ciasym miejsen bez mailiwabe cyrkulaci pewi
cirza wokol nicgo.

North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Riickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften Uber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Réntgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine bauartgleiche
eingebaut wird.

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.
s ABRHS

BERE E (ATFEBFSSREHEENE) (LR ASEAMHRHS)
BFHasE TAF SR S nE e EY RS T ANERTISE

ARBERZ G
BRE (RRERCRT)

SR

ZREE
(PBB)

R
(PBDE)

o|o|o

ol

O
o)

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhdhte Augenbelastung bei zu geringem
Zeichenkontrast waren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

() |ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT

ZUGANGLICH SIND.
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7 Customer care and warranty

7.1 Philips' Flat Panel Monitors Pixel Defect
Policy
Philips strives to deliver the highest quality
products. We use some of the industry's most
advanced manufacturing processes and practice
stringent quality control. However, pixel or sub
pixel defects on the TFT monitor panels used in
flat panel monitors are sometimes unavoidable.
No manufacturer can guarantee that all panels will
be free from pixel defects, but Philips guarantees
that any monitor with an unacceptable number
of defects will be repaired or replaced under
warranty. This notice explains the different types
of pixel defects and defines acceptable defect
levels for each type. In order to qualify for repair
or replacement under warranty, the number of
pixel defects on a TFT monitor panel must exceed
these acceptable levels. For example, no more
than 0.0004% of the sub pixels on a monitor may
be defective. Furthermore, Philips sets even higher
quality standards for certain types or combinations
of pixel defects that are more noticeable than
others.This policy is valid worldwide.

subpixel subpixel

vy
S

Pixels and Sub pixels

A pixel, or picture element, is composed of three
sub pixels in the primary colors of red, green and
blue. Many pixels together form an image. When
all sub pixels of a pixel are lit, the three colored
sub pixels together appear as a single white pixel.
When all are dark, the three colored sub pixels
together appear as a single black pixel. Other
combinations of lit and dark sub pixels appear as
single pixels of other colors.

subpixel

Types of Pixel Defects

Pixel and sub pixel defects appear on the screen
in different ways. There are two categories of pixel
defects and several types of sub pixel defects
within each category.

Bright Dot Defects

Bright dot defects appear as pixels or sub pixels
that are always lit or 'on'.That is, a bright dot is

a sub-pixel that stands out on the screen when
the monitor displays a dark pattern.There are the
types of bright dot defects:

One lit red, green or blue sub pixel

I C

Two adjacent lit sub pixels:

- Red + Blue = Purple

- Red + Green =Yellow

- Green + Blue = Cyan (Light Blue)

Three adjacent lit sub pixels (one white pixel)




& Note

A red or blue bright dot must be more than 50

percent brighter than neighboring dots while
a green bright dot is 30 percent brighter than

neighboring dots. .

Black Dot Defects
Black dot defects appear as pixels or sub pixels
that are always dark or 'off' . That is, a dark dot is

a sub-pixel that stands out on the screen when Proximity of Pixel Defects
the monitor displays a light pattern. These are the ~ Because pixel and sub pixels defects of the same
types of black dot defects. type that are near to one another may be more

noticeable, Philips also specifies tolerances for the
proximity of pixel defects.

I Pixel Defect Tolerances

In order to qualify for repair or replacement due
to pixel defects during the warranty period, a

TFT monitor panel in a Philips flat panel monitor
must have pixel or sub pixel defects exceeding the
tolerances listed in the following tables.

BRIGHT DOT DEFECTS ACCEPTABLE LEVEL

1 lit subpixel 3

2 adjacent it subpixels 1

3 adjacent lit subpixels (one white pixel) 0
Distance between two bright dot defects* >15mm
Total bright dot defects of all types 3

1 dark subpixel 5 or fewer
2 adjacent dark subpixels 2 or fewer
3 adjacent dark subpixels 0
Distance between two black dot defects* >15mm
Total black dot defects of all types 5 or fewer
TOTAL DOT DEFECTS ACCEPTABLE LEVEL
Total bright or black dot defects of all types 5 or fewer

@ Note

1 or 2 adjacent sub pixel defects = 1 dot defect
This monitor is 1ISO9241-307 compliant. (1IS509241-307: Ergonomic requirement , analysis and
compliance test methods for electronic visual displays)
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7.2 Customer Care & Warranty

Customer Care & Warranty

For warranty coverage information and additional support requirement valid for your region, please
visit wwwi.philips.com/support website for details. You may also contact your local Philips Customer

Care Center number listed below.

Contact Information for WESTERN EUROPE region:

Country ASC Consumer care number Price
Austria Siemens &S +43 0810 000206 €0.07
Belgium E Care +32 078 250851 €0.06
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09
Germany Siemens &S +49 01803 386 853 €0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
[taly A-novo +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Contact Information for CENTRAL AND EASTERN EUROPE region:

Country Call center  ASC Consumer care number
Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Czech Rep. NA Asupport 800 100 697
Estonia NA FUJITSU +372 6519900
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080
Latvia NA “ServiceNet LV Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
E— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
soroa f‘egm NA KimTec do.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
U NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
Turkey NA Techpro +90 212 444 4 832

Contact Information for LATIN AMERICA region:

Country Call center Consumer care number
Argentina Vermont 0800 3330 856
Brazil Vermont 0800-7254101

Contact Information for NORTH AMERICA:

Country Call center ASC Consumer care number
Canada Supercom Supercom (800)479-6696
USA. TOS Teleplan (877) 835-1838

Contact Information for CHINA:

China

Consumer care number : 4008 800 008




Contact Information for APMEA region:

Country Call center ASC Consumer care number
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992
buy-out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 56677
‘ , ‘ , . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 273741116
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea | NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no dlistributor and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
Jnited Arab 0 AL SHAHD COMPUTER LLL.C |00971 4 2276525
Emirates
FPT Service Inf i +84 8 38248007 Ho Chi Minh City
Vietnam NA ervice iniormeatic +84 5113.562666 Danang City

Company Ltd.

+84 5113.562666 Can tho Province
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8 Troubleshooting & FAQs

8.1 Troubleshooting

This page deals with problems that can be
corrected by a user: If the problem still persists
after you have tried these solutions, contact Philips
customer service representative.

E Common Problems

No Picture (Power LED not lit)

*  Make sure the power cord is plugged into the
power outlet and into the back of the monitor.

*  First, ensure that the power button on the
front of the monitor is in the OFF position,
then press it to the ON position.

No Picture (Power LED is white blinking)

*  Make sure the computer is turned on.

* Make sure the signal cable is properly
connected to your computer.

* make sure the monitor cable has no bent pins
on the connect side. If yes, repair or replace
the cable.

*  The Energy Saving feature may be activated

Screen says

Attention

Check cable connection

* Make sure the monitor cable is properly
connected to your computer. (Also refer to
the Quick Start Guide).

» Check to see if the monitor cable has bent
pins.

* Make sure the computer is turned on.

AUTO button doesn't function

* The auto function is applicable only in VGA-
Analog mode. If the result is not satisfactory,
you can do manual adjustments via the OSD
menu.

& Note

The Auto Function is not applicable in
DVI-Digital mode as it is not necessary.

Visible signs of smoke or sparks

* Do not perform any troubleshooting steps

* Disconnect the monitor from mains power
source immediately for safety

»  Contact with Philips customer service
representative immediately.

B Imaging Problems

Image is not centered

* Adjust the image position using the “"Auto”
function in OSD Main Controls.

* Adjust the image position using the Phase/
Clock of Setup in OSD Main Controls. It is
valid only in VGA mode.

Image vibrates on the screen
*  Check that the signal cable is properly securely
connected to the graphics board or PC.

Vertical flicker appears

* Adjust the image using the “Auto” function in
OSD Main Controls.

* Eliminate the vertical bars using the Phase/
Clock of Setup in OSD Main Controls. It is
valid only in VGA mode.



Horizontal flicker appears

* Adjust the image using the “Auto” function in
OSD Main Controls.

* Eliminate the vertical bars using the Phase/
Clock of Setup in OSD Main Controls. It is
valid only in VGA mode.

Image appears blurred, indistinct or too dark
* Adjust the contrast and brightness on
On-Screen Display.

An "after-image", "burn-in" or "ghost image"

remains after the power has been turned off.

*  Uninterrupted display of still or static images
over an extended period may cause " burn
in", also known as "after-imaging " or "ghost
imaging", on your screen. "Burn-in", "after-
imaging", or "ghost imaging" is a well-known
phenomenon in monitor panel technology. In
most cases, the "burned in" or "after-imaging”
or "ghost imaging" will disappear gradually over
a period of time after the power has been
switched off.

» Always activate a moving screen saver
program when you leave your monitor
unattended.

* Always activate a periodic screen refresh
application if your monitor will display
unchanging static content.

» Severe” burn-in" or “after-image” or “ghost
image"” symptoms will not disappear and
cannot be repaired. The damage mentioned
above is not covered under your warranty.

Image appears distorted. Text is fuzzy or blurred.

* Set the PC’s display resolution to the same
mode as monitor's recommended screen
native resolution.
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Green, red, blue, dark, and white dots appears on
the screen

The remaining dots are normal characteristic
of the liquid crystal used in today's technology,
Please refer the pixel policy for more detail.

The "power on" light is too strong and is

disturbing

You can adjust “power on" light using the
power LED Setup in OSD main Controls.

H Audio problem

No sound

Check if audio cable is connected to PC and
monitor correctly.

Ensure audio is not muted. Press OSD “Menu’”,
select “Audio” then “Mute”". Check it on “Off"”
position.

Press “Volume” in OSD main control to adjust
the volume.

B USB problem

USB peripherals are not working

Check if USB upstream cable is connected to
your monitor correctly

Turn your monitor OFF and ON once again.
You may need to install/reinstall USB drivers in
your PC and ensure hub is active.

Reconnect your USB peripherals

For further assistance, refer to the Consumer
Information Centers list and contact Philips
customer service representative.
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Q1.

Q2.

Ans.:

SmartControl Premium FAQs

| change the monitor on a PC to a different
one and the SmartControl Premium
becomes un-usable, what do | do?

. Restart your PC and see if SmartControl
Premium can work. Otherwise, you will
need to remove and re-install SmartControl
Premium to ensure proper driver is installed.

The SmartControl Premium functions
worked well before, but it does not work
anymore, what can | do?

If the following actions were executed, the
monitor driver may need to be

re-installed.

Changed video graphic adapter to another
one

Updated video driver

Activities on OS, such as service pack or patch
Run Windows Update and updated monitor
and/or video driver

Windows was booted with the monitor
power off or disconnected.To find out,

please right click My Computer and click on
Properties->Hardware-> Device Manager. If
you see "Plug and Play Monitor" shows under
Monitor, then you need to re-install. Simply
remove SmartControl Premium and re-install
it.

Q3

Q4.

After installing SmartControl Premium,
when clicking on SmartControl Premium
tab, nothing shows up after a while or a
failure message shows, what happened?

.t It might be your graphic adaptor is not

compatible with the SmartControl Premium.
If your graphic adaptor is one of the above
mentioned brands, try to download the
most updated graphic adaptor driver from
corresponding companies’ web site. Install
the driver, Remove SmartControl Premium,
and re-install it once more.

If it is still not working, we are sorry that
the graphic adaptor is not supported. Please
visit Philips website and check if an updated
SmartControl Premium driver is available.

When | click on Product Information,
only partial information is shown, what
happened?

.2 It might be your graphic card adaptor driver

is not the most updated version which fully
supporting DDC/CI interface. Please try to
download the most updated graphic adaptor
driver from corresponding companies’ web
site. Install the driver. Remove SmartControl
Premium and re-install it once more.

Attention

Theft Deterence enabled




Q5.

Ans.:

Qé.

Ans.:

| forgot my PIN for Theft Deterrence
Function.What can | do?

Philips Service center has a right to ask for
legitimate identification and authorization, in
order to establish ownership of the monitor.

Please note that the anti-theft deterrence
function is provided as a convenient free
option. Managing PIN numbers is the sole
responsibility of the individual user or the
organization who sets it.

In case the PIN number is forgotten,
Philips service center can re-set it for you
at a nominal charge after verification of
ownership. Please note that this activity is
not covered by standard warranty terms.

In a monitor with the Smartlmage feature,
the sRGB scheme of color temperature
function in SmartControl Premium is not
responding, why?

When Smartlmage is enabled, the sSRGB
scheme is disabled automatically. To use
sRGB, you need to disable Smartimage with
the E]) button at the front bezel of your
monitor.
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Q1:

Ans

Q2: What is the recommended refresh rate for

Ans.:

General FAQs

When [ install my monitor what should |
do if the screen shows 'Cannot display this
video mode"?

:Recommended resolution for this monitor:
1920x1080 @60Hz.

Unplug all cables, then connect your PC to the

monitor that you used previously.

In the Windows Start Menu, select Settings/
Control Panel. In the Control Panel

Window, select the Display icon. Inside the
DisplayControl Panel, select the 'Settings' tab.
Under the setting tab, in box labeled 'desktop
area', move the sidebar to 1920x1080 pixels.
Open 'Advanced Properties' and set the
Refresh Rate to 60Hz, then click OK.

Restart your computer and repeat step

2 and 3 to verify that your PC is set at
1920x1080@60Hz.

Shut down your computer, disconnect your
old monitor and reconnect your Philips
monitor.

Turn on your monitor and then turn on your
PC.

monitor?

Recommended refresh rate in monitors is
60Hz. In case of any disturbance on screen,
you can set it up to 75Hz to see if that
removes the disturbance.

Q3:

Ans.:

Q4.

Ans.:

Q5:

Ans.:

Qé:

Ans.:
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What are the .inf and .icm files on the CD-
ROM? How do | install the drivers (.inf and
.icm)?

These are the driver files for your monitor.
Follow the instructions in your user manual
to install the drivers.Your computer may ask
you for monitor drivers (.inf and .icm files)
or a driver disk when you first install your
monitor. Follow the instructions to insert
the ( companion CD-ROM) included in this
package. Monitor drivers (.inf and .icm files)
will be installed automatically.

How do | adjust the resolution?

Your video card/graphic driver and monitor

together determine the available resolutions.
You can select the desired resolution under

Windows® Control Panel with the "Display

properties".

What if | get lost when | am making
monitor adjustments via OSD?

Simply press the OK button, then select
‘Reset’ to recall all of the original factory
settings.

Is the monitor screen resistant to
scratches?

In general it is recommended that the panel
surface is not subjected to excessive shocks
and is protected from sharp or blunt objects.
When handling the monitor, make sure that
there is no pressure or force applied to

the panel surface side. This may affect your
warranty conditions.



Q7.

Ans

Qs8:

Ans.:

Q9:

Ans.:

How should | clean the monitor surface?!

.. For normal cleaning, use a clean, soft cloth.
For extensive cleaning, please use isopropyl
alcohol. Do not use other solvents such as
ethyl alcohol, ethanol, acetone, hexane, etc.

Can | change the color setting of my
monitor?

Yes, you can change your color setting
through OSD control as the following
procedures,

Press "OK" to show the OSD (On Screen

Display) menu

Press "Down Arrow" to select the option

"Color" then press "OK" to enter color setting,

there are three settings as below.

1. Color Temperature; The six settings are
5000K, 6500K, 7500K, 8200K, 9300K and
11500K. With settings in the 5000K range
the panel appears ‘warm," with a red-white
color tone, while a 11500K temperature
yields ‘cool, blue-white toning."

2. sRGB; this is a standard setting for ensuring
correct exchange of colors between
different device (e.g. digital cameras,
monitors, printers, scanners, etc)

3. User Define; the user can choose his/her
preference color setting by adjusting red,
green blue color.

Note:

A measurement of the color of light

radiated by an object while it is being heated.

This measurement is expressed in terms of

absolute scale, (degrees Kelvin). Lower Kevin

temperatures such as 2004K are red; higher
temperatures such as 9300K are blue.

Neutral temperature is white, at 6504K.

Can the Philips monitor be mounted on
the wall?

Yes. Philips monitors have this optional
feature. Four standard VESA mount holes
on the rear cover allows the user to
mount the Philips monitor on most of the

48

VESA standard arms or accessories. We
recommend you to contact your Philips
sales representative for more information.

Q10: Can | connect my monitor to any PC,

Ans.:

workstation or Mac?

Yes. All Philips monitors are fully compatible
with standard PCs, Macs and workstations.
You may need a cable adapter to connect
the monitor to your Mac system. Please
contact your Philips sales representative for
more information.

Q11: Are Philips monitors Plug-and- Play?

Ans.:

Yes, the monitors are Plug-and-Play
compatible with Windows 7/Vista/XP/NT,
Mac OSX, Linux

Q12: What is Image Sticking, or Image Burn-in,

Ans.:

or After Image, or Ghost Image in monitor
panels?

Uninterrupted display of still or static images
over an extended period may cause "burn
in", also known as "after-imaging” or "ghost
imaging", on your screen. "Burn-in", "after-
imaging", or "ghost imaging" is a well-known
phenomenon in monitor panel technology. In
most cases, the "burned in" or "atter-imaging”
or "ghost imaging" will disappear gradually
over a period of time after the power has
been switched off. Always activate a moving
screen saver program when you leave your
monitor unattended.

Always activate a periodic screen refresh
application if your monitor will display
unchanging static content.

) Warning

Severe"burn-in" or "after-image" or'ghost
image" symptoms will not disappear and
cannot be repaired. The damage mentioned
above is not covered under your warranty.



Q13: Why is my Display not showing sharp text,
and is displaying jagged characters?

Ans.: Your monitor works best at its native
resolution of 1920x1080@60Hz. For best
display please use this resolution.
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